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1 

Introduction 

Oracle Enterprise Governance, Risk and Compliance (GRC) regulates activity in 

business-management applications. This document provides instructions for the instal-

lation or upgrade of the following GRC products: 

• Oracle Enterprise Governance, Risk and Compliance Manager (EGRCM) forms 

a documentary record of a company’s strategy for addressing risk and complying 

with regulatory requirements. 

• Oracle Advanced Controls enables users to create “models” and “continuous con-

trols.” Two Advanced Controls applications run from within the GRC platform: 

– In Oracle Enterprise Transaction Controls Governor (ETCG), models and 

controls specify circumstances under which individual transactions display 

evidence of error, fraud, or other risk.  

– In Oracle Application Access Controls Governor (AACG), models and 

controls define conflicts among duties that can be assigned in a company’s 

applications, and identify users who have access to those conflicting duties. 

AACG can also implement “preventive analysis” — it can evaluate controls 

as duties are assigned to users of the company’s applications, preventing them 

from gaining risky access. 

• Oracle Fusion GRC Intelligence (GRCI) extracts data from GRC for display in 

dashboards and reports. 

You can install GRC on its own, or to be integrated with an OID LDAP server that 

manages GRC users. (OID stands for Oracle Internet Directory; LDAP for Lightweight 

Directory Access Protocol.)  

You can embed a GRCI instance within GRC. To use GRCI, install GRC first (see 

chapter 2). Then integrate GRCI with GRC (see chapter 3). 
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Prerequisites 

You can install GRC 8.6.6.11000 only as an upgrade to version 8.6.6.10000. GRC 

runs on a 64-bit Linux server and requires the following.  

• An Oracle 12.1.0.2 (12c) database, by preference. During earlier upgrades, you 

may have retained an Oracle 11.2.0.4 or 11.2.0.3 database. You can continue to 

use that database with version 8.6.6.11000. 

In the database, a GRC schema must be created. If you implement GRCI, a data 

analytics (DA) schema must exist as well. The database that supports the GRC 

schema must use the AL32UTF8 character set. 

If you want to upgrade to the 12c database, follow this sequence to install GRC 

8.6.6.11000: Upgrade your database to 12c, import your GRC schema to the 12c 

database, upgrade GRC, then point your GRC instance to the new database (see 

“GRC Configuration” beginning on page 7). 

• Java: Oracle JDK 1.7. GRC must have its own dedicated Java container. It was not 

designed to coexist in a container with other web applications. 

• Middleware: To support GRC, WebLogic Server 12c (12.1.3) or Tomcat Appli-

cation Server 7.0.82. These versions are certified.  

If you use WebLogic Server (WLS), you also need the version of Application 

Development Runtime (ADR) and Repository Creation Utility (RCU) that 

matches the number of your WLS version. In the 12c release, RCU is packaged 

with ADR. 

To run GRCI, you need WLS 11g (10.3.6); this is true even if you use WLS 12c 

to support GRC itself. WLS 11g runs with RCU and ADR at release 11.1.1.7 if 

you support GRC with Tomcat, or at release 11.1.1.9 if you support GRC with 

WLS 12c. 

As an option, an OID LDAP server can manage GRC users. 

On the server or a client system, the following web browsers can display the GRC 

interface: Microsoft Internet Explorer 11x or Firefox 38.5 or 43.04.  

For details about supported components, see the Oracle Enterprise Governance, 

Risk and Compliance Certifications Document. 

Recording Configuration Values 

Make a note of certain configuration values for version 8.6.6.10000, as you will 

need to re-enter them for version 8.6.6.11000. All these values are displayed in the 

GRC Manage Application Configurations page. (Start the GRC 8.6.6.10000 

instance, then select Navigator → Setup and Administration → Setup → Manage 

Application Configurations). 

• Select a Properties tab and note values you will need to enter in a ConfigUI 

page during 8.6.6.11000 installation. 

• If you have set up GRC to work with an OID LDAP repository, select a User 

Integration tab and note the values entered there. 

• If you use GRCI, select an Analytics tab and note the values entered there. 
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Downloading Files 

Create a staging directory on your GRC server. (Throughout this document, 

<grc_stage> represents the full path to this directory.) 

To upgrade GRC, download a file called grc866_11006.zip to <grc_stage>, and 

extract its contents there. To validate your download, generate a checksum and 

compare it with a checksum value published in Release Notes for the instance you 

are installing. To generate a checksum, run the command md5sum grc.ear (if you 

run GRC with WebLogic) or md5sum grc.war (if you run GRC with Tomcat). 

If you use WebLogic to support GRC, you may already have embedded GRCI in 
your GRC instance. If so, you must reinstall GRCI. You can embed GRCI even if 
you have not done so in an earlier release. To do so, however, you must have created 
a Data Analytics (DA) schema for GRC 8.6.6.1000 and reconnected it to GRC in 
each subsequent release. In either case, download three files to your <grc_stage> 
directory: 

• grc866_11_OBIEE_1of3.tar.gz 

• grc866_11_OBIEE_2of3.tar.gz 

• grc866_11_OBIEE_3of3.tar.gz 

For you to embed GRCI in GRC, your instance must run with WebLogic. If you use 
Tomcat, you can run GRCI only as a standalone application. You do not need the three 
grc866_11_OBIEE files for standalone GRCI. 
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2 

Upgrading GRC 

As you upgrade to GRC 8.6.6.11000: 

• You may continue to use the database installed for your 8.6.6.10000 instance or, 

if that database is 11.2.0.3 or 11.2.0.4, you may upgrade to 12c. In the latter 

case, perform the upgrade and import your GRC and DA schemas to the new 

database before completing the procedures in this chapter. 

• If you have not already done so, upgrade to middleware certified for GRC 

8.6.6.11000: WebLogic 12.1.3 or Tomcat 7.0.82.  

• Reuse Java Development Kit 1.7, already installed for GRC 8.6.6.10000.  

GRC Repositories 

For your earlier version of GRC, you should have created two “repositories” — 

directories that store data generated by GRC. A report repository stores copies of 

GRC reports that users schedule to be run. A second repository stores synchroniza-

tion data used for transaction analysis. 

Reuse these repositories for GRC 8.6.6.11000. Retain the contents of the transaction 

synchronization repository. Note the paths to the repositories, as you will need to 

supply them later as configuration values. 

Upgrading GRC Only 

If you intend to reuse existing WebLogic 12.1.3 or Tomcat 7.0.82 components as 

you upgrade GRC, begin here. If you must upgrade WebLogic or Tomcat as well as 

GRC, skip ahead either to “Upgrading GRC and WebLogic” on page 15 or to “Up-

grading GRC and Tomcat” on page 23. The process to upgrade only GRC involves 

these steps: 

1. Ensure that two directories, for the storage of GRC report data and ETL data, 

are ready for use (see “GRC Repositories,” above). 

2. Remove some files installed for your GRC 8.6.6.10000 instance, and run a setup 

script. 
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3. Restart the WebLogic or Tomcat application server, then perform configuration 

steps in a GRC ConfigUI page. 

4. Restart your application server to complete the installation. 

Back up your database, schema, middleware components, and report and transaction 

ETL repositories. 

GRC with WebLogic 

If you installed GRC to run with WebLogic Server, complete the following steps.  

1. Stop the WebLogic Administration Server and (if any exist in your installation) 

managed servers. 

2. During installation of earlier GRC releases, a directory called grc866 was created, 

typically as a subdirectory of your middleware home directory (represented in this 

document as <MW_HOME>). Delete the contents of the grc866 directory. 

3. Navigate to <grc_stage>/dist, and locate a grc.ear file. 

4. Extract the contents of grc.ear into the grc866 directory. 

5. Navigate to <grc_stage>/dist. From there, run the file grc_wls_setup.sh. Supply 

the path to the grc866 directory (into which you extracted the contents of the 

grc.ear file in step 4). For example: 

cmd> ./grc_wls_setup.sh <MW_HOME>/grc866 

6. Remove content from the following directories. (In these paths, <grc_domain> 

represents the name of the WebLogic domain created for GRC during installa-

tion of version 8.6.6.1000, and <managed_server> is the name of a WebLogic 

managed server, if one was created during installation of version 8.6.6.1000.) 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/AdminServer/logs 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/AdminServer/cache 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/AdminServer/tmp 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/<managed_server>/ 

logs 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/<managed_server>/

cache 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/<managed_server>/ 

tmp 

When these procedures are complete, restart the WebLogic servers. 

GRC with Tomcat 

If you installed GRC to run with Tomcat Application Server, complete the follow-

ing steps: 

1. Shut down the Tomcat Application Server. 

2. Remove the directory <TomcatHome>/webapps/grc and all its contents. 

3. Remove the Catalina directory from the Tomcat work area (<TomcatHome>/work/ 

Catalina). Delete the contents of <TomcatHome>/temp. Also delete Tomcat logs, 

located at <TomcatHome>/logs. (You may want to save them to another location.) 
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4. Navigate to <TomcatHome>/webapps and delete the grc.war file. 

5. Navigate to <grc_stage>/dist. From there, run the file grc_tomcat_setup.sh. 

Supply the paths to the <grc_stage>/dist subdirectory, <TomcatHome>, and the 

full path to your Java home as parameters: 

cmd> ./grc_tomcat_setup.sh <grc_stage>/dist <TomcatHome> 

<JavaHomePath> 

6. Copy the file xdoparser-10.1.3.4.jar from <grc_stage>/lib to 

<TomcatHome>/webapps/grc/WEB-INF/lib. 

7. Start the Tomcat application server. 

GRC Log-On URL 

When you installed release 8.6.6.1000 of GRC, you may have set it up to support 

Secure Sockets Layer (SSL) or Transaction Layer Security (TLS). How you log on 

to GRC depends on whether it does or does not support SSL or TLS. 

If you have not set up GRC to use SSL or TLS, log on with the following URL: 

http://host:http_port/grc 

Replace host with the fully qualified domain name (FQDN) of your GRC server. 

Select one of the following values for http_port: 

• If you use WebLogic 12c, enter the port number you chose for the Administra-

tion Server as you created a WebLogic domain. 

• If you use Tomcat, enter 8080 (if you accepted the default value when you 

installed Tomcat) or your configured value (if you changed the default during 

Tomcat installation). 

If you have set up GRC to use SSL or TLS, log on with the following URL: 

https://host:https_port/grc 

Again, replace host with the FQDN of your GRC server. Select one of the following 

values for https_port: 

• If you use WebLogic 12c, enter the port number you selected as the SSL Listen 

Port when you set up SSL or TLS for GRC. 

• If you use Tomcat, enter the port number you selected as the Connector Port 

when you set up SSL for GRC. 

However, a third logon URL applies if you set up GRC to recognize Single Sign On 

(SSO). See “Integrating with Single Sign On Authentication,” beginning on page 11. 

GRC Configuration 

Regardless of whether you use WebLogic or Tomcat, perform GRC-specific config-

uration: 

1. Open a ConfigUI page: Navigate to your GRC log-on URL. If prompted, supply 

the admin user ID along with a password established for that user ID during instal-

lation of version 8.6.6.1000. 
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2. In the Installation Configuration section, type or select appropriate property 

values: 

• User Name: Supply the user name for the GRC database. 

• Password: Supply the password for the GRC database.  

• Confirm Password: Re-enter the password for the GRC database.  

• Port Number: Supply the port number at which the GRC database server 

communicates with other applications.  

• Service Identifier: Supply the service identifier (SID) for the GRC database 

server, as configured in the tnsnames.ora file.  

• Server Name: Supply the FQDN of the database server.  

• Maximum DB Connections: Default is 50. You can edit this value. 

• Report Repository Path: Supply the full path to the Report Repository 

directory discussed in “GRC Repositories” on page 5.  

• Log Threshold: Select a value that sets the level of detail in log-file entries. 

From least to greatest detail, valid entries are error, warn, info, debug, and 

trace. Select trace only if Oracle Support instructs you to do so. 

• Transaction ETL Path: Enter the full path to the directory you created to 

hold ETL data used by Enterprise Transaction Controls Governor (see 

“GRC Repositories” on page 5). 

• App Server Library Path: Enter the full path to the library subdirectory of 

your web application server (for use in the upload of custom connectors for 

AACG). If you use Tomcat Application server and intend to enable parallel 

processing (see step 4 below), set this field to the “lib/adf” subdirectory of the 

Tomcat home directory. 

3. In the Language Preferences section of the ConfigUI page, select check boxes 

for up to twelve languages in which you want GRC to be able to display infor-

mation to its users. “English (U.S.)” should be selected by default; do not 

deselect it. 

4. In the Performance Configuration section of the ConfigUI page, select or clear 

check boxes: 

• Optimize Appliance-Based Operation: Select the check box to optimize 

performance if the GRC application and GRC schema reside on the same 

machine. Do not select this check box if the GRC application and schema 

do not reside on the same machine. When you select this check box, an 

ORACLE_HOME Path field appears. In it, enter the full, absolute path to your 

Oracle Home — the directory in which you have installed the Oracle data-

base that houses the GRC schema. 

• Enable Graph Synchronization Date Limit: “Data synchronization” enables 

GRC to recognize data changes in each business application subject to 

models and controls. Although the concept applies to AACG and ETCG, 

the process works differently for the two applications. 
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Either application recognizes “business objects,” each of which is a set of 

related fields from a “data source” (business application). ETCG distin-

guishes among three categories of business object — Transaction (in which 

records are created or updated frequently), and Operational and Configura-

tion (consisting of master-data or setup records that change infrequently).  

For ETCG only, select the Enable Graph Synchronization Date Limit check 

box to cause the synchronization of Transaction business objects to operate 

only on records created or updated in data sources on or after a specified date.  

The setting of this check box has no effect on ETCG Operational or Config-

uration business objects, for which a synchronization run encompasses all 

records, no matter when they were created or updated. Moreover, AACG 

does not distinguish among business-object categories, and the setting of 

this check box has no effect on AACG synchronization runs. 

When you select the check box, a Transactions Created As Of field appears. 

In it, enter the cutoff date for the synchronization of ETCG Transaction busi-

ness objects. When you click in the field, a pop-up calendar appears. Click 

left- or right-pointing arrows to select earlier or later months (and years), 

and then click on a date in a selected month. 

• Externalize Report Engine: Select the check box to enable the reporting 

engine to run in its own java process, so that the generation of large reports 

does not affect the performance of other functionality. But select the check 

box only if you have installed GRC on hardware identified as “certified” in 

the Oracle Enterprise Governance, Risk and Compliance Certifications Doc-

ument; clear the check box if you use hardware identified as “supported.” 

• Enable Parallel Processing: Select this check box to enable multiple jobs to 

run simultaneously. When you select the Enable Parallel Processing check 

box, two fields appear:  

Number of Cores Available for Processing: Enter the number of processor 

cores you wish to devote to parallel processing. GRC uses one core for each 

job, until as many cores as you specify here are in use.  

Maximum Megabytes of Physical RAM Available: Specify an amount of 

memory for use in parallel processing. Ensure that this value is at least 16 

GB times the number of cores. GRC then divides the memory value by the 

core value to determine the actual amount of memory per core.  

This value is in addition to what is already allocated to the WebLogic 

Admin server or Tomcat server. Review the amount of memory allocated to 

other processes (such as Linux or database management) before allocating 

memory to parallel processing. Important: Allocating more memory than 

what is available causes disk swapping, which causes poor performance 

during peak load. 

• Enforce Allocated Analysis Time Per Filter: Select this check box, and 

enter a number in the Minutes field, to limit the time that transaction models 

and controls can run.  

A model or control consists of filters, each of which defines some aspect of 

a risk and selects transactions that meet its definition. When the Allocated 

Analysis Time feature is enabled, each filter runs no longer than the number 
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of minutes you specify. If time expires, the filter passes records it has selected 

to the next filter for analysis, but ignores records it has not yet examined. So 

a filter may not capture every record that meets its definition, and the model 

or control results are labeled “partial” in GRC job-management pages.  

Once enabled here, this feature may be disabled for individual models (and 

for the controls developed from those models). This feature applies only to 

transaction models and controls, not to access models and controls, and not 

to EGRCM objects.  

5. In the ConfigUI page, click on Actions → Save. GRC tests the values you’ve 

entered and, if they are valid, saves them. (If any are invalid, an error message 

instructs you to re-enter them.) 

6. Exit the ConfigUI page.  

Completing the Installation 

With components in place and properly configured, complete the installation, in 

effect by running your web application server.  

1. Shut down your server — the Administration Server if you’re using WebLogic, 

or the Tomcat application server if you’re using Tomcat. Then restart the server. 

2. In a web browser, enter the GRC URL (see “GRC Log-On URL,” page 7).  

3. Wait for a progress bar to indicate that initialization is complete.  

4. You are redirected to a GRC logon page. Log on to the application. Use the 

admin user ID, with a password established for that user ID during the installation 

of version 8.6.6.1000. 

If you have not set up an external OID LDAP repository to manage users, basic 

GRC installation is complete. (You may, however, choose complete other proce-

dures described later.) 

If you have set up an OID LDAP repository, complete these additional steps: 

1. In GRC, select Navigator → Setup and Administration → Setup → Manage 

Application Configurations. 

2. To configure external OID LDAP, select the User Integration tab and enter the 

following values: 

• Enable Single Sign On: See “Integrating with Single Sign On Authentica-

tion” on page 11. 

• Enable Integration: Select the check box to permit integration with LDAP to 

occur. 

• User Name: Supply the user name (common name) to log in to the LDAP 

server. This user should have admin privileges.  

• Password: Enter the password for the user identified in the User Name field. 

• Confirm Password: Re-enter the password for the user identified in the User 

Name field. 
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• Port: Enter the port number at which the LDAP server communicates with 

other applications. 

• Server Name: Enter the host name of the LDAP server.  

• Bind DN Suffix: Enter the “User Base DN.”  

• Enable SSL Authentication: Select the box to allow GRC to access the LDAP 

server through SSL. If you select this option, the LDAP server must be con-

figured to support SSL. 

• Perform LDAP Recursive Search: Select the check box to search recursively 

for users in subfolders along with those in the base path specified in the Bind 

DN Suffix field. 

• Unique User Identifier: uid 

3. In the Manage Application Configurations page, click on Actions → Save. Then 

log off of GRC. 

4. Stop the GRC Deployment in the WebLogic Console: 

a Log in to the WebLogic Console at  

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number 

you selected for the WebLogic Administration Server as you set up a 

WebLogic domain. 

b From the Domain Structure menu, select Deployments. 

c From the Deployment page, locate the GRC deployment and verify the state 

is Active. 

d Click the checkbox next to the GRC deployment. 

e From the toolbar, click Stop → Force Stop Now. 

5. Start the GRC Deployment in the WebLogic Console: 

a From the Domain Structure menu, select Deployments. 

b From the Deployment page, locate the GRC deployment and verify the state 

is Prepared. 

c Click the checkbox next to the GRC deployment. 

d From the toolbar, click Start → Servicing All Requests.  

Integrating with Single Sign On Authentication 

Rather than use the GRC authentication system to authenticate GRC users, you can 

integrate GRC with Oracle Access Management (OAM) Single Sign On (SSO). To do 

so, you must have installed GRC to run with WebLogic; SSO is not supported in a GRC 

instance that runs with Tomcat. Moreover, you require not only OAM 11gR2, but 

also Oracle HTTP Server (OHS) 11g Webgate for OAM. 
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First, register OHS Webgate 11g Agent for OAM 11g: 

1. Log on to the OAM console. Its URL is 

http://<oam_host>:<oam_port>/oamconsole, in which <oam_host> is 

the host name of the OAM server, and <oam_port> is its port number.  

2. On the Agents grid of the Application Security tab, select Create Webgate. 

3. On the Create Webgate page, enter the following values: 

• Version: Select 11g. 

• Name: Enter any value to create a name for the agent.  

• Base URL: Enter http://<host>:<port>, in which <host> is the host 

name of the machine where Oracle HTTP Server 11g Webgate is installed, 

and <port> is its port number.  

• Security: Select Open.  

• Host Identifier: Enter either the Name or the Base URL value. 

• Select the Auto Create Policies check box. 

• In the Protected Resource List, add /grc. 

Leave the Access Client Password and User Defined Parameters fields blank, 

and leave the Virtual Host and IP Validation checkboxes unselected.  

4. Click the Apply button.  

5. The Create Webgate page refreshes. In a new Logout URL field, enter a logout 

URL, for instance /oamsso/logout.html. 

6. Click the Apply button again.  

Once the agent is created, update the authentication scheme to your LDAP scheme:  

1. Select the Application Security tab.  

2. Click Application Domains, then search for and select your agent name.  

3. Select the Authentication Policies tab. On it, click Protected Resource Policy. 

4. Click the Open icon.  

5. Select your LDAP authentication scheme. 

6. Click the Apply button. 

Next, create a response: 

1. Select the Application Security tab. 

2. Click Application Domains, then search for and select your agent name. 

3. Select the Authorization Policies tab. On it, click Protected Resource Policy. 

4. Click the Add icon. 

5. Enter these values: 

• Name: OAM_REMOTE_USER 

• Type: Header 

• Value: $user.userid 
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6. Click Add. 

7. Click the Apply button. 

Next, copy the Webgate artifacts.  

1. Copy ObAccessClient.xml and cwallet.sso 

From: <oam_domain_home>/output/<agent>/ 

To: <MW_HOME>Oracle_WT1/instances/instance1/config/OHS/ohs1/ 

webgate/config 

Next, modify OHS to redirect to GRC.  

1. On the server on which you’ve installed OHS, navigate to 

<MW_HOME>/Oracle_WT1/instances/instance1/config/OHS/ohs1.  

2. Open the mod_wl_ohs.conf file in a text editor and add the following infor-

mation to it: 

<IfModule weblogic_module> 

  Debug ON 

  WLLogFile /tmp/weblogic.log 

</IfModule> 

<Location /grc> 

  SetHandler weblogic-handler 

  WebLogicHost <GRC_HOST_NAME> 

  WebLogicPort <GRC_PORT_NUMBER> 

</Location> 

Replace <GRC_HOST_NAME> with the FQDN of your GRC server. Replace 

<GRC_PORT_NUMBER> the number of your HTTP Port if SSL is not enabled, or 

your HTTPS Port if SSL is enabled. See “GRC Log-On URL” (page 7) for 

more information on identifying these port numbers. 

3. Save and close the mod_wl_ohs.conf file. 

4. Restart the OAM server and Webgate. 

Next, add the OAM Identity Asserter to the GRC domain: 

1. Log in to the WebLogic Server Administration Console: 

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number you 

selected for the WebLogic Administration Server.  

2. Click Lock and Edit. 

3. Click Security Realms (on the left under Domain Structure), then click myrealm. 

4. In the Providers tab, click the New button, and enter OAM Identity Asserter for 

both Name and Type. Then click the OK button. 

5. In the Providers tab, click the newly created OAM Identity Asserter. 

6. In the Common tab, select: 

• ControlFlag: Required 

• Active Types — Choose: OAM_REMOTE_USER (remove ObSSOCookie 

from the Chosen box) 

Click the Save option. 
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7. Return to the Providers tab, click on DefaultAuthenticator, change the 

ControlFlag to SUFFICIENT, and click the Save option.  

8. In the Providers tab, reorder the authentication providers so that OAM Identity 

Asserter is first, DefaultAuthenticator is second, and DefaultIdentityAsserter is 

third. Then click the OK button. 

9. Click Activate Changes and restart the application server.  

Finally, enable SSO in GRC: 

1. Log on to GRC and select Navigator → Setup and Administration → Setup → 

Manage Application Configurations. Select the User Integration tab. (You are 

presumed to have already set OID LDAP values on this page, as described in 

“Completing the Installation,” beginning on page 10.) 

2. Select the Enable Single Sign On check box.  

3. Enter your logout URL in the OAM 11gR2 Logout URL field.  (This should be 

the same value as you entered in the Create Webgate page as you registered an 

agent for GRC.) 

4. Select the Save option from the Actions menu. Verify that you receive a message 

stating that configuration values were saved successfully. 

5. Select Navigator → Setup and Administration → Security → Manage Users. 

Select the Import from LDAP option from the Actions menu and import users. 

6. To enable SSO logout: 

• Log off of GRC and navigate to <MW_HOME>/wlserver/common/bin/. 

• Execute the following command to start wlst.sh: 

./wlst.sh 

• Execute the following command at the wls:/> prompt: 

addOAMSSOProvider(loginuri="/${app.context}/adfAuthentication", 

logouturi="/oamsso/logout.html", autologinuri="/obrar.cgi") 

Once you have configured SSO for GRC, the URL to access GRC is: 

http://<webgate_host>:<webgate_port>/grc 

Or, if a secure protocol like SSL or TLS has been enabled in the OAM application 

server, the leading characters of the URL are https:// 

https://<webgate_host>:<webgate_port>/grc 

Communicate this URL to all GRC users. 

GRC and SSL 

When you installed release 8.6.6.1000 of GRC, you may have set it up to support 

Secure Sockets Layer (SSL). If you run GRC with WebLogic, you implemented by 

default a Transaction Layer Security (TLS) version 1.0 certificate. You can upgrade 

to the TLS version 1.2 certificate. To do so, see steps 25–27 of “Implementing SSL 

with TLS v1.2 if GRC Runs with WebLogic” (page 27). 

Moreover, complete the following steps to ensure that GRC communicates properly 

with preventive enforcement agents (PEAs) installed in Oracle E-Business Suite 

instances subject to AACG analysis.  



 

 Upgrading GRC 15 

1. Copy the file axis2.xml from <grc_stage>/conf to: 

• <MW_HOME>/user_projects/domains/<grc_domain>/grc/WEB-INF/conf, if 

you installed GRC to run with WebLogic. 

• <TomcatHome>/webapps/grc/WEB-INF/conf, if you installed GRC to run 

with Tomcat. 

2. Copy the file addressing-1.7.3.mar from <grc_stage>/modules to: 

• <MW_HOME>/user_projects/domains/<grc_domain>/grc/WEB-INF/modules, 

if you installed GRC to run with WebLogic. 

• <TomcatHome>/webapps/grc/WEB-INF/modules, if you installed GRC to 

run with WebLogic. 

3. Open the axis2.xml file in a text editor. In it, search for the following text: 

<transportReceiver name="http" 

class="org.apache.axis2.transport.http.AxisServletListener">  

<parameter name="port"><add HTTP Port></parameter>  

</transportReceiver>  

<transportReceiver name="https" 

class="org.apache.axis2.transport.http.AxisServletListener">  

<parameter name="port"><add HTTPS Port></parameter>  

</transportReceiver> 

4. In that passage:  

• Replace the phrase “add HTTP Port” with the number of the port GRC 

would use if SSL were not enabled. 

• Replace the phrase “add HTTPS Port” with the number of the port GRC 

uses once SSL is enabled. 

See “GRC Log-On URL” (page 7) for more information on identifying these 

port numbers. 

Upgrading GRC and WebLogic 

If you are upgrading WebLogic to version 12.1.3 as you upgrade GRC to version 

8.6.6.11000, the process involves these steps: 

1. Ensure that two directories, for the storage of GRC report data and ETL data, 

are ready for use (see “GRC Repositories,” page 5). 

2. Install WebLogic Server, along with Application Development Runtime (which 

includes Repository Creation Utility). 

3. Create a WebLogic domain. This entails setting up an Administration Server. 

4. If you intend for an OID LDAP repository to manage GRC users, configure that 

repository. 

5. Modify memory and other settings to conform to GRC requirements, and per-

form configuration steps in a WebLogic Server Administration Console. 

6. Perform configuration steps in a GRC ConfigUI page. 

7. Run WebLogic to complete the installation. 
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Setting Up WebLogic 

As you install WebLogic Server (WLS) and related components, you make choices 

that support their use with GRC.  

Initial WebLogic Installation 

Ensure that Oracle JDK 1.7 is in the path to install and run WebLogic Server.  

Install WLS 12c (12.1.3) as a standard default deployment. Also install ADR 12c, 

which includes RCU 12c. Consult WebLogic documentation for detailed proce-

dures. 

Once ADR 12c is installed, run RCU to create WebLogic repositories. Required 

RCU components include AS Common Schemas and all its subcomponents. As you 

run RCU, expand AS Common Schemas and verify that all subcomponents are 

selected.   

Creating a WebLogic Domain 

Create a new WebLogic domain. To do so, execute the following command to run a 

Fusion Middleware Configuration Wizard:  

<MW_HOME>/wlserver/common/bin/config.sh 

Note: <MW_HOME> represents the full path to the home directory of a given 

middleware installation — the highest-level directory in which Fusion Middleware 

components exist, including WebLogic. Also, <grc_domain> represents the name 

you give to the domain you create for a given WebLogic instance. 

The Wizard prompts you to select a domain location, select templates, create a 

domain name, create a name and password for an “administration account,” and 

complete other steps. In most cases, you should consult WebLogic documentation to 

understand your options, and are free to make configuration decisions that suit your 

preferences. However, note the following: 

• Select these four templates:  

Basic WebLogic Server Domain — 12.1.3.0 [wlserver] 

Oracle Enterprise Manager — 12.1.3.0 [em] 

Oracle JRF — 12.1.3.0 [oracle_common] 

WebLogic Coherence Cluster Extension — 12.1.3.0 [wlserver]  

• When prompted, select “Production” for your Domain Mode, and ensure that 

the correct JDK is selected. (This is the JDK instance you confirmed to be in the 

path to install and run WebLogic under “Initial WebLogic Installation” on page 

16.) If necessary, use the “Other JDK Location” option to browse. 

• When prompted, choose to create an Administration Server. You need not cre-

ate any managed servers. 
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Preparing Additional Files 

Complete these additional steps when the config.sh script finishes running: 

1. Copy the following files from <grc_stage>/lib to <MW_HOME>/user_projects/ 

domains/<grc_domain>/lib: 

• groovy-all-2.0.5.jar  

• xdoparser-10.1.3.4.jar 

• jython-2.7.1.jar 

• adfdt_common.jar 

• adfm-12.1.3_V2.jar 

• adfmweb.jar 

2. Create a directory called grc866 (for example, <MW_HOME>/grc866). This 

directory should be entirely distinct from the <grc_stage> directory you created 

as you downloaded GRC files. 

3. Navigate to <grc_stage>/dist, and locate the file grc.ear. Extract its contents to 

the grc866 directory.  

In addition, as you complete GRC installation procedures, you will use scripts named 

startWeblogic.sh and stopWeblogic.sh to start and stop the WebLogic Administration 

Server. First, edit the stopWeblogic.sh file as follows: 

1. Open <MW_HOME>/user_projects/domains/<grc_domain>/bin/stopWeblogic.sh 

in a text editor. 

2. Locate a line in the file similar to the following: 

echo "shutdown('${SERVER_NAME}','Server', 

ignoreSessions='true')" 

>>"shutdown.py" 

3. Edit this line to include a force=‘true’ parameter: 

echo "shutdown('${SERVER_NAME}','Server', force='true', 

ignoreSessions='true')" 

>>"shutdown.py" 

4. Save and close the file.  

Whenever you run the stopWeblogic.sh script, wait 30 seconds for all processes to 

terminate.  

Configuring External OID LDAP 

This section applies to you only if you intend to install GRC so that an external OID 

LDAP repository manages its users. If so, complete the following steps. If not, skip 

ahead to “Modifying Settings” (page 20). 

1. Log in to the WebLogic Server Administration Console: 

http://host:port/console 

In this URL, replace host with the fully qualified domain name (FQDN) of your 

GRC server, and port with the number you selected for the WebLogic Administra-

tion Server as you set up a WebLogic domain.  
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2. Click on the “Security Realms” link in your application’s Security Settings. 

3. Click on the “myrealm” link in the table. 

4. Click on the “Providers” tab. 

5. Click on the New button and enter the following values: 

• Name: OIDAuthenticator 

• Type: OracleInternetDirectoryAuthenticator 

6. Click on the “OIDAuthenticator” link and then click on the “Provider Specific” tab. 

7. Supply values for properties in the “Provider Specific” screen. (Italicized entries 

are literal values, to be entered as they are shown.) 

• Host: The FQDN of the LDAP provider (your OID instance). 

• Port: The port number at which the host communicates with other applica-

tions. 

• Principal: The username for the OID administrative user, preceded by cn=. 

• Credential: The password configured for the OID administrative user. 

• Confirm Credential: The password configured for the OID administrative user. 

• SSLEnabled: Leave this box unchecked. 

• User Base DN: The LDAP path to the store for user information. For example: 

cn=FusionUsers,cn=users,dc=us,dc=oracle,dc=com 

• All Users Filter: (&(cn=*)(objectclass=person)) or 

(&(uid=*)(objectclass=person)), depending on your configuration.  

• User From Name Filter: (&(cn=%u)(objectclass=person)) or 

(&(uid=%u)(objectclass=person)), depending on your configuration.  

• User Search Scope: subtree 

• User Name Attribute: cn or uid, depending on your configuration.  

• User Object Class: person 

• Use Retrieved User Name as Principal: Select this checkbox. 

• Group Base DN: The LDAP path to the store for group (enterprise role) 

information. For example: cn=FusionGroups,cn=groups,dc=us,dc=oracle, 

dc=com 

• All Groups Filter: (&(cn=*)(|(objectclass=groupofUniqueNames) 

(objectclass=orcldynamicgroup))) 

• Group From Name Filter: (|(&(cn=%g)(objectclass=groupofUniqueNames)) 

(&(cn=%g)(objectclass=orcldynamicgroup))) 

• Group Search Scope: subtree 

• Group Membership Searching: unlimited 

• Static Group Name Attribute: cn 

• Static Group Object Class: groupofuniquenames 
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• Static Member DN Attribute: uniquemember 

• Static Group DN from Member DN filter: (&(uniquemember=%M)(objectclass= 

groupofuniquenames)) 

• Dynamic Group Name Attribute: cn 

• Dynamic Group Object Class: orcldynamicgroup 

• Dynamic Member URL Attribute: labeleduri 

• User Dynamic Group DN Attribute: Leave this field blank. 

• Connection Pool Size: 6 

• Connect Timeout: 0 

• Connection Retry Limit: 1 

• Parallel Connect Delay: 0 

• Results Time Limit: 0 

• Keep Alive Enabled: Leave this box unchecked. 

• Follow Referrals: Select this checkbox. 

• Bind Anonymously On Referrals: Leave this box unchecked. 

• Propagate Cause For Login Exception: Leave this box unchecked. 

• Cache Enabled: Select this checkbox. 

• Cache Size: 32 

• Cache TTL: 60 

• GUID Attribute: orclguid 

8. Save your settings, then click on “Activate Changes” on the left, topmost panel. 

9. Click the “OIDAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

10. Click the “DefaultAuthenticator” link from the authenticator list, and set the 

Control Flag to SUFFICIENT. 

11. Click the Reorder button. Select “OIDAuthenticator” from the available provid-

ers, and move it to the top. To do so, click on the arrow on the right side, then 

click OK. 

12. Click on “Activate Changes” from the Change Center, then log out. 

13. Stop the WebLogic Administration Server.  

14. Edit boot.properties files. There are two possibilities: 

• GRC and OID LDAP components exist on one instance of WebLogic 

Server (WLS). If so, a boot.properties file exists for the Administration 

Server. 

In this case, edit the file to set a username value equal to your OID admin-

istrative user name — the “Principal” in step 7 of this procedure, without 

the cn= prefix. Set a password value equal to that user’s password — the 

“Credentials” value in step 7 of this procedure. 
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• GRC and OID LDAP exist on distinct instances of WLS. In this case, two 

boot.properties files exist, for the GRC Administration Server on the GRC 

instance of WLS, and for the OID Administration Server on the OID LDAP 

instance of WLS. 

In this case, edit boot.properties files on the OID LDAP instance of WLS to 

set the username and password values equal to those for the OID adminis-

trative user (as defined earlier in this step). Edit boot.properties files on the 

GRC instance of WLS to set the username and password values to those 

you created as you set up a WebLogic domain (page 16). 

The boot.properties file for the Administration Server exists at 

<MW_HOME>/user_projects/domains/<grc_domain>/servers/AdminServer/secur

ity/boot.properties 

15. Start the Administration Server. Check whether LDAP is configured 

successfully: Log in to the WebLogic console (see step 1of this procedure), go 

to Security Realms → myRealm, and click on Users and Groups. You should 

see your LDAP users and groups.  

Modifying Settings 

For any installation, modify settings in a file called setDomainEnv.sh, which is 

located in the <MW_HOME>/user_projects/domains/<grc_domain>/bin directory.  

1. Stop the Administration Server.  

2. Navigate to setDomainEnv.sh and open it in a text editor.  

3. In the file, locate the following lines: 

# IF USER_MEM_ARGS the environment variable is set, use it 

to override ALL MEM_ARGS values 

if [ "${USER_MEM_ARGS}" != "" ] ; then 

Insert the following lines between those two lines:  

case "${SERVER_NAME}" in 

"AdminServer") 

  USER_MEM_ARGS="-Xms4g –Xmx16g" 

;; 

"bi_server1") 

  USER_MEM_ARGS="-Xms2g –Xmx8g" 

;; 

"soa_server1") 

  USER_MEM_ARGS="-Xms2g –Xmx4g" 

;; 

"sample_server1") 

  USER_MEM_ARGS="-Xms4g -Xmx16g" 

;; 

"sample_server2") 

  USER_MEM_ARGS="-Xms4g -Xmx16g" 

;; 

*) 

  echo "Unknown Server Detected!!. Memory set as Xms1g 

Xmx2g."; 

USER_MEM_ARGS="-Xms1g -Xmx2g" 

;; 

esac 
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USER_MEM_ARGS="${USER_MEM_ARGS} -XX:PermSize=256m  

-XX:MaxPermSize=512m -XX:ReservedCodeCacheSize=128M  

-Djava.awt.headless=true  

-Djbo.ampool.maxpoolsize=600000  

-Dfile.encoding=UTF-8  

-Djavax.xml.bind.context.factory=com.sun.xml.internal.bind.

v2.ContextFactory" 

-Doracle.jdbc.autoCommitSpecCompliant=false 

Replace “placeholder” names (AdminServer, bi_server1, soa_server1, 

sample_server1, and sample_server2) with the names of your Administration 

Server and any managed servers included in your installation. 

You may use a maximum memory setting (-Xmx) larger than 16G if your server 

has enough memory to support the larger value.  

4. Locate the following section of the file and ensure that “-da” appears after each 

of two “${enableHotSwapFlag}” elements: 

if [ "${debugFlag}" = "true" ] ; then 

JAVA_DEBUG="-Xdebug -Xnoagent  

-Xrunjdwp:transport=dt_socket,address=${DEBUG_PORT},server

=y,suspend=n -Djava.compiler=NONE" 

export JAVA_DEBUG 

JAVA_OPTIONS="${JAVA_OPTIONS} ${enableHotswapFlag} -da  

-da:com.bea... -da:javelin... -da:weblogic...  

-ea:com.bea.wli... -ea:com.bea.broker...  

-ea:com.bea.sbconsole..." 

export JAVA_OPTIONS 

else 

JAVA_OPTIONS="${JAVA_OPTIONS} ${enableHotswapFlag} -da" 

export JAVA_OPTIONS 

fi 

5. Locate the EXTRA_JAVA_PROPERTIES section of the file. In it, remove the 

following string: 

-Dorg.apache.commons.logging.Log=org.apache.commons.logging.

impl.Jdk14Logger 

6. Locate the following lines in the file: 

if [ "${PRE_CLASSPATH}" != "" ] ; then 

CLASSPATH="${PRE_CLASSPATH}${CLASSPATHSEP}${CLASSPATH}" 

export CLASSPATH 

fi 

Add the following before those lines: 

PRE_CLASSPATH="<MW_HOME>/user_projects/domains/<grc_domain>

/lib/jython-2.7.1.jar:${PRE_CLASSPATH}" 

export PRE_CLASSPATH 

Replace <MW_HOME> and <grc_domain> with the actual values appropriate for 

your environment.  

7. Save and close the file. Start the Administration Server. 
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Using the WebLogic Console to Deploy the GRC Application 

For any installation, use the WebLogic Server Administration Console to complete 

additional configuration steps: 

1. Log in to the WebLogic Server Administration Console at 

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number you 

selected for the WebLogic Administration Server as you set up a WebLogic 

domain. 

2. In the Change Center pane, click Lock & Edit. 

3. In the Domain Structure pane, click on Deployments. 

4. In the Summary of Deployments pane, select the Control tab. 

5. In the Summary of Deployments pane, click on the Install button. 

6. In the Path field of the Install Application Assistant pane, enter the full path to 

the grc866 directory you created earlier (see step 2 of “Preparing Additional 

Files” on page 17). Select “grc866 (open directory)” under Current Location. 

7. In the Install Application Assistant pane, press next.  

8. In the Install Application Assistant pane, choose Install this deployment as an 

application in the “Choose targeting style” section. 

9. In the Install Application Assistant pane, press Next.  

10. In the Install Application Assistant pane, choose I will make this deployment 

accessible from the following location in the “Source accessibility” section. 

Accept all other defaults. 

11. In the Install Application Assistant pane, press Next. 

12. In the Install Application Assistant pane, choose Yes, take me to the deploy-

ment’s configuration screen in the “Additional configuration” section. 

13. In the Install Application Assistant pane, press Finish. 

14. In the Install Application Assistant pane, press Save, then Activate Changes. On 

the Deployments screen, the state of the grc866 application will be Prepared.  

15. Select the grc866 application. Click Start, select Servicing all requests, click Yes on 

Start Application Assistant,  and wait until the application status changes to Active. 

Continuing the Upgrade 

Next, perform the procedures documented in these sections: 

• “GRC Configuration,” page 7. 

• “Completing the Installation,” page 10. 

• If appropriate for your installation: 

– “Integrating with Single Sign On Authentication,” page 11. 

– “Installing a Driver for RAC,” page 24. 

– “GRC and SSL,” page 24. 
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Upgrading GRC and Tomcat 
If you are upgrading Tomcat to version 7.0.82 as you upgrade GRC to version 

8.6.6.11000, the process involves these steps: 

1. Ensure that two directories, for the storage of report and ETL data generated by 

GRC, are ready for use (see “GRC Repositories,” page 5). 

2. Install Tomcat (as instructed in its documentation).  

3. On the GRC server, modify Tomcat memory settings, and run a Tomcat setup 

script provided with GRC. 

4. Perform configuration steps in a GRC ConfigUI page. 

5. Run Tomcat to complete the installation. 

Setting Up Tomcat Application Server 

To install GRC with Tomcat 7.0.82: 

1. Download and install Tomcat generally as its documentation instructs you to do.  

2. Shut down the Tomcat application server. 

3. Modify Tomcat settings. In <TomcatHome>/bin, create the file setenv.sh. 

(Note: Throughout this document, <TomcatHome> represents the full path to the 

highest-level directory in which Tomcat components are installed.) Include the 

following lines in setenv.sh: 

CATALINA_OPTS="-Xss512k -Xms256M –Xmx16G -XX:MaxPermSize=256m  

-XX:+UseParallelGC -Djava.awt.headless=true 

-XX: UseGCOverheadLimit -XX:ReservedCodeCacheSize=128M  

-Doracle.mds.cache=simple -Dfile.encoding=UTF 8" 

export CATALINA_OPTS 

You may use a maximum memory setting (-Xmx) larger than 16G if your server 

has enough memory to support the larger value. 

4. Navigate to <grc_stage>/dist. From there, run the file grc_tomcat_setup.sh 

Supply the paths to <grc_stage>/dist subdirectory, <TomcatHome>, and the full 

path to your Java home as parameters: 

cmd> ./grc_tomcat_setup.sh <grc_stage>/dist <TomcatHome> 

JavaHomePath 

5. Start the Tomcat application server. 

Continuing the Upgrade 

Next, perform the procedures documented in these sections: 

•  “GRC Configuration,” page 7. 

• “Completing the Installation,” page 10. 

• If appropriate for your installation: 

– “Integrating with Single Sign On Authentication,” page 11. 

– “Installing a Driver for RAC,” page 24. 

– “GRC and SSL,” page 24. 
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Installing a Driver for RAC 

If Real Application Clusters (RAC) is enabled in your GRC database, you must set 

up a jdbc-oci driver. (If you do not use RAC, this section does not apply.) 

1. Shut down your WebLogic administration server.  

2. In a web browser, go to http://www.oracle.com/technetwork/database/features/ 

instant-client/index-097480.html. Select the Instant Client link for the platform 

on which you are installing, then find the Basic download for 11.2.0.3.0. 

3. Download and unzip the package into a single directory, such as “instantclient.”  

4. Set the library loading path in your environment to this directory before starting 

the application. On many Linux platforms, LD_ LIBRARY_PATH is the appropri-

ate environment variable. 

5. Copy the file ojdbc6.jar from the instant client to <TomcatHome>/webapps/grc/ 

WEB-INF/lib if you installed GRC to run with Tomcat, or to grc866/grc/WEB-INF/lib 

if you installed GRC to run with WebLogic. (In the latter case, you created grc866 

as a home directory for your GRC installation in step 2 of “Preparing Additional 

Files” on page 17.) 

6. Restart your web application server.  

GRC and SSL 

Once GRC in installed, you can set it up to support Secure Sockets Layer (SSL). 

GRC support for SSL is optional. 

Implementing SSL with TLS v1.2 if GRC Runs with WebLogic 

To install and configure SSL support for a GRC instance that runs with WebLogic, 

first create custom certificates, then enable and configure SSL. 

To create custom certificates: 

1. Navigate to the config directory of your WebLogic domain — 

<MW_HOME>/user_projects/domains/<grc_domain>/config. 

2. Create a self-signed keystore. Run the following command. (Here and throughout 

this section, replace <Java_Home> with the full path to the highest-level direc-

tory in which Java components are installed.) 

<Java_Home>/bin/keytool -genkey -alias grc -keyalg RSA  

-keysize 1024 -dname "CN=KeyMachine,OU=Unit, O=ORG, 

L=Locality, ST=StateProvince, C=CountryCode" -keypass 

KeyPassword -keystore KeyFileName.jks -storepass StorePassword 

In this command, replace italicized values as follows (and enter other values as 

they are shown). 

• -alias: Accept grc, or enter any other value. (If you choose a value other 

than grc, be sure to use that same value where you need to supply the alias 

in subsequent commands in this procedure.) 
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• -dname parameters: 

CN stands for Common Name. Replace KeyMachine with the fully quali-

fied domain name of the machine on which the keystore is being generated 

(the GRC server). 

OU and O: Replace Unit with the name of an organizational unit, and Org 

with the name of the parent organization of that unit. You can supply any 

values you choose. 

L, ST, and C: Replace Locality with the name of a city or municipality; 

StateProvince with the name of a state, province, or other political subdivi-

sion of a country; and CountryCode with a two-letter country code.  

• -keypass and -storepass: Replace KeyPassword and StorePassword with 

passwords that you create as you run this command. It’s recommended that 

you use the same value for both passwords. (These values, established here, 

will be used in subsequent commands.)  

• -keystore: Replace KeyFileName with any name for a keystore file. (The file 

extension must be .jks, and the name, established here, will be used in subse-

quent commands.) 

3. Self-sign the certificate. Run the following command.  

<Java_Home>/bin/keytool -selfcert -v -alias grc -keypass 

KeyPassword -validity 8000 -keystore KeyFileName.jks  

-storepass StorePassword -storetype jks 

Again, replace italicized values as follows (and enter other values as they are 

shown). 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keypass and -storepass: Replace KeyPassword and StorePassword with the 

passwords you created in step 2.  

• -keystore: Replace KeyFileName with the keystore file name you created in 

step 2.  

4. Export the root certificate. Run the following command: 

<Java_Home>/bin/keytool -export -v -alias grc -keystore 

KeyFileName.jks -storepass StorePassword -file rootCA.der 

Again, replace italicized values as follows (and enter other values as they are 

shown). 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keystore: Replace KeyFileName with the keystore file name you created in 

step 2. 

• -storepass: Replace StorePassword with the password you created in step 2.  

• -file: Replace rootCA with a file name of your choosing. (The file extension 

must be .der, and the name, established here, will be used in a subsequent 

command.) 
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5. Import the root certificate into a trusted keystore. Run the following command: 

<Java_Home>/bin/keytool -import -v -trustcacerts -alias 

grc -keystore trust.jks -storepass StorePassword -file 

rootCA.der 

Again, replace italicized values as follows (and enter other values as they are 

shown): 

• -alias: Replace grc with the alias you created in step 2 (or use grc if you 

accepted that value in step 2). 

• -keystore: Replace trust with a new keystore name. This must not be the 

same as the -keystore value entered in earlier steps, but otherwise may be 

any value you wish. (The file extension must be .jks.)  

• -storepass: Replace StorePassword with the password you created in step 2. 

• -file: Replace rootCA with the file name you created in step 4. (The file 

extension must be .der.) 

When prompted “Trust this certificate? [no],” enter yes to confirm the key import. 

To enable SSL: 

1. Log in to the WebLogic Server Administration Console at 

http://host:port/console 

Replace host with the FQDN of your GRC server, and port with the number you 

selected for the WebLogic Administration Server as you set up a WebLogic 

domain. 

In the left panel of the Console, expand Environment and select Servers. 

2. Click the name of the Administration Server on which GRC is installed. 

3. In the Change Center of the Administration Console, click Lock & Edit. 

4. Select the Configuration tab and then the General subtab. 

5. Select the checkbox next to SSL Listen Port Enabled. 

6. Enter a port number in the SSL Listen Port textbox. 

7. Select Save. Click Activate Changes in the Change Center of the Administration 

Console. 

Repeat this procedure for any managed servers. 

To configure SSL: 

1. Still in the Administration Console, expand Environment and select Servers. 

2. Click the name of the Administration Server on which GRC is installed. 

3. In the Change Center of the Administration Console, click Lock & Edit. 

4. Select the Configuration tab and then the Keystores subtab. 

5. In the Keystore row, click the Change button. From the drop-down list, select 

Custom Identity and Custom Trust. 

6. In the Custom Identity Keystore field, enter the full path to your keystore file 

(the .jks file you created at step 2 in the procedure for creating custom certifi-

cates, page 24).  
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7. Enter JKS as the value for Custom Identity Keystore Type. 

8. For the Custom Identity Keystore Passphrase, enter the value you chose for 

the -storepass parameter at step 2 in the procedure for creating custom certifi-

cates (page 24). 

9. Re-enter the -storepass value in the Confirm Custom Identity Keystore Pass-

phrase field.  

10. In the Custom Trust Keystore field, enter the full path to your trusted keystore 

file (the .jks file you created at step 2 in the procedure for creating custom cer-

tificates, page 24). 

11. Enter JKS as the value for Custom Trust Keystore Type. 

12. For the Custom Trust Keystore Passphrase, enter the value you chose for 

the -storepass parameter at step 2 in the procedure for creating custom certifi-

cates (page 24). 

13. Reenter the -storepass value in the Confirm Custom Trust Keystore Passphrase field. 

14. Select Save. Click Activate Changes in the Change Center of the Administration 

Console.  

15. In the Change Center of the Administration Console, click Lock & Edit. 

16. Click on the SSL subtab, to the right of the Keystore subtab. 

17. Ensure that the Identity and Trust Locations value is set to “Keystores.” If not, 

change it to this value.  

18. Set the value of the Private Key Alias to the value you chose for the -alias 

parameter at step 2 in the procedure for creating custom certificates (page 24). 

19. For the Private Key Passphrase, enter the values you chose for the -keypass 

parameter at step 2 in the procedure for creating custom certificates (page 24). 

20. Reenter that -keypass value in the Confirm Private Key Passphrase field. 

21. Expand the Advanced options of the SSL subtab by clicking on the Advanced 

pane title. 

22. Select the Use JSSE SSL checkbox. 

23. Select Save. Click Activate Changes in the Change Center of the Administration 

Console. 

24. Log out of the WebLogic Administration Console: click on the Log Out link at 

the top of the console page. 

25. Open <MW_HOME>/user_projects/domains/<grc_domain>/bin/setDomainEnv.sh 

in a text editor. Locate the following lines: 

# IF USER_MEM_ARGS the environment variable is set, use it 

to override ALL MEM_ARGS values  

if [ "${USER_MEM_ARGS}" != "" ] ; then 

26. Insert the following as the USER_MEM_ARGS variable: 

-Dweblogic.security.SSL.protocolVersion=TLSv1.2 
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27. Bounce the Administration Server, then ensure there are no SSL-related errors 

in the server log. 

28. Navigate to https://host:SSLport/console to test your latest changes. (The 

SSLport is the value you selected in step 6 of the procedure for enabling SSL, 

page 26.) 

Repeat this procedure for any managed servers. 

Implementing SSL with TLS v1.2 if GRC Runs with Tomcat 

To install and configure SSL support for a GRC instance that runs with Tomcat, 

prepare a certification keystore, then modify a server.xml file.  

To prepare the certification keystore, which contains a single self-signed certificate: 

1. Execute the following command from a terminal command line.  

<Java_Home>/bin/keytool -genkey -alias grc -keyalg 

RSA -keystore <TomcatHome>/conf/keystore -storetype pkcs12 

This command creates a new file, named “keystore,” in the conf directory of 

your <TomcatHome>. 

2. In response to a prompt, create a keystore password. (Note that you will need to 

specify this password later as you edit the server.xml file.) 

3. In response to a prompt, confirm the password you just created. 

4. In response to prompts, provide general information about the certificate, such 

as company, contact name, and so on. (This information is displayed to users 

who attempt to access a secure page in your application.) 

To modify the server.xml file: 

1. Navigate to <TomcatHome>/conf, and open the server.xml file for editing. 

2. In the file, locate a Connector element that looks like the following: 

<!--  

Define a SSL HTTP/1.1 Connector on port 8443 

This connector uses the JSSE configuration, when using 

APR, the connector should be using the OpenSSL style 

configuration described in the APR documentation  

--> 

<!-- 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLSv1.2" /> 

--> 

3. From the second block of text, delete the comment tags (<!-- and -->).  

4. Accept the default value for the port attribute (8443), or change it to any other 

value. This is the TCP/IP port number on which Tomcat listens for secure con-

nections. Note that special setup (outside the scope of this document) is neces-

sary to run Tomcat on port numbers lower than 1024 on many operating systems. 
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If you change the port number, also change the value for the redirectPort attribute 

on the non-SSL connector you use. This lets Tomcat redirect users who attempt 

to access a page with a security constraint specifying that SSL is required. 

5. Add values to the connector element — keystoreFile, keystorePass, keyAlias, 

and keystoreType attributes. A completed connector element looks like the 

following (in which you would replace YourKeystorePassword with the pass-

word you created as you prepared the certification keystore): 

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 

maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslProtocol="TLSv1.2" 

keystoreFile="<TomcatHome>/conf/keystore" 

keystorePass="YourKeystorePassword" keyAlias="grc" 

keystoreType="PKCS12" /> 

6. Restart Tomcat.  

PEA Support 

To ensure that GRC communicates properly with preventive enforcement agents 

installed in Oracle E-Business Suite instances subject to AACG analysis, complete 

steps documented in the separate “GRC and SSL” section on page 14. 

Accessing GRC 

After configuring SSL successfully, access the GRC application at 

https://host:SSLport/grc, in which host is the FQDN of your GRC server, and 

SSLport is the port you selected to support SSL. (If you use WebLogic, see step 6 of 

the procedure for enabling SSL on page 26. If you use Tomcat, see step 4 above.) 

Because you are using a self-signed certificate, which is not signed by an official 

Certificate Authority, you get a security warning when you open GRC at this URL.  

• For Internet Explorer, the warning reads, "There is a problem with this 

website’s security certificate.” Dismiss this warning by choosing “Continue to 

this website (not recommended).” 

• For Firefox, the warning reads, “This Connection is Untrusted.” Dismiss this 

warning by clicking “I Understand the Risks,” and then “Add Exception.”  
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3 

Integrating GRCI 

Oracle Fusion GRC Intelligence (GRCI) makes use of Oracle Business Intelligence 

Enterprise Edition (OBIEE) and a Data Analytics (DA) schema.  

You can update an instance of GRCI already integrated with GRC8.6.6.10000. The 

process depends on whether you use Tomcat or WebLogic to support GRC: 

• If you use Tomcat, you need only reconnect your DA schema.  

• If you use WebLogic, you must both reconnect your DA schema and reinstall 

GRCI according to instructions in this chapter. The new installation addresses a 

security issue. It uses new OBIEE installation files. 

You can install GRCI if you have not done so for earlier GRC releases. A prerequi-

site, however, is that you have created the DA schema for a GRC release that could 

be installed independently of earlier releases — in this case, 8.6.6.1000 — and then 

reconnected the schema to GRC for each subsequent upgrade-only release. For an 

initial installation: 

• If you use Tomcat to support GRC, obtain version 8.6.6.1000 of the GRC 

Installation Guide and follow its instructions for installing OBIEE and supporting 

middleware components. 

• If you use WebLogic to support GRC, follow instructions in this chapter. 

Connecting to the DA Schema 

The GRC schema used by GRC supplies data to the DA schema used by GRCI. For 

this to happen, you need to enter connectivity information in GRC.  

1. Log on to GRC (see “GRC Log-On URL,” page 7). Select Navigator → Tools 

→ Setup and Administration → Setup → Manage Application Configurations → 

Analytics. 

2. In the Data Analytics Configuration section, enter values that identify the DA 

schema. (These are values that you noted earlier. See “Recording Configuration 

Values” on page 2.) 

• User Name: Supply the user name for the DA database. 

• Password: Supply the password for the DA database. 
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• Confirm Password: Re-enter the password for the DA database. 

• Port Number: Supply the port number at which the database server 

communicates with other applications. 

• Service Identifier: Supply the service identifier (SID) for the database 

server. 

• Server Name: Supply the fully qualified domain name of the database server. 

3. When you finish entering property values, click on Actions → Save. GRC tests 

the values you’ve entered and, if they are valid, saves them. (If any are invalid, 

an error message instructs you to re-enter them.) 

4. Look for the prompt, “Successfully saved configuration values.”  

After that message appears, a one-time process runs in the background. It creates the 

DA schema tables and views. This process takes approximately fifteen minutes. Do 

not stop your WebLogic or Tomcat server during this period.  

Once you have connected to the DA schema, set a schedule on which the schema is 

refreshed — on which the DA schema reads from the GRC schema. You can modify a 

schedule at any time. (A refresh can take up to 90 minutes to finish.)  

1. Select the Analytics tab of the Manage Applications Configurations page.  

2. Click on the Schedule Data Analytics Update button.  

3. A Schedule Parameter dialog opens. Enter values that set the name of the sched-

ule, its start date and time, the regularity with which the DA schema should be 

refreshed, and an end date (if any). Then click on the Schedule button.  

4. Click on Actions → Save.  

To view the status of a scheduled refresh, go to Tools → Setup and Administration 

→ Manage Jobs. To view the Data Analytics schedule, go to Tools → Setup and 

Administration → Manage Scheduling.  

Setting Up OBIEE in GRC with WebLogic 

You will install WebLogic 11g — WebLogic Server (WLS) 10.3.6, ADR 11.1.1.9, 

and RCU 11.1.1.9 — and then deploy OBIEE within your 11g WebLogic domain.  

The WebLogic components replace the WLS, RCU, and ADR components installed 

previously for earlier versions of GRCI. You will be deploying new OBIEE files, 

and you cannot do so over the OBIEE files already existing in your earlier WLS 11g 

instance. So you need a new instance. 

These components are in addition to WebLogic 12c components you installed to sup-

port GRC itself. You will have two independent WebLogic instances.  

WebLogic Installation 

Ensure that Oracle JDK 1.7 is in the path to install and run WLS. Then install WLS 

11g (10.3.6) as a standard default deployment. Also install RCU 11.1.1.9 and ADR 

11.1.1.9.  
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In general, adapt installation procedures already documented for WebLogic 12c in 

the previous chapter. In particular, see the following sections: 

• Initial WebLogic Installation, page 16. 

• Creating a WebLogic Domain page 16. 

• Preparing Additional Files, page 17. 

• Using the WebLogic Console to Deploy the GRC Application, page 22. 

However, note the following differences: 

• As you create a WebLogic domain, you select templates. The correct templates 

for 11g are: 

– Base WebLogic Server Domain — 10.3.6.0 

– Oracle Enterprise Manager — 11.1.1.0 

– Oracle JRF — 11.1.1.0 

• As you prepare additional files, copy the following from <MW_HOME>/ 

oracle_common/modules/oracle.adf.model_11.1.1 to <MW_HOME>/user_ 

projects/domains/<grc_domain>/lib. 

– adfm.jar 

– adfdt_common.jar 

– adfmweb.jar 

Copy these files from <grc_stage>/lib to <MW_HOME>/user_projects/domains/ 

<grc_domain>/lib: 

– groovy-all-1.6.3.jar  

– xdoparser-10.1.3.4.jar 

– jython-2.7.1.jar 

Preparing OBIEE Files 

Locate the files grc866_11_OBIEE_1of3.tar.gz, grc866_11_OBIEE_2of3.tar.gz, and 

grc866_11_OBIEE_3of3.tar.gz  in your <grc_stage> directory (see “Downloading 

Files,” page 3). Extract their contents in the 11g < MW_HOME>. This overwrites some 

files under the oracle_common directory. 

Running the Installation Script 

Run an installation script, which prompts you for settings that apply to your instance. 

The entire process is logged to <MW_HOME>/installation.log. 

Pay attention to script output on your monitor. Some installation stages may cause 

errors or may require your attention. Should errors occur, check the log file.  

To run the script, execute the following command in your 11g <MW_HOME>: 

./install_obiee.sh 

The script determines whether X Server is running. (If not, the script directs you to 

start X Server, then exits. In a later step, you will use a graphical user interface, and 
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X Server is required for that interface to be displayed.) Next, the script reminds you 

to shut down your administration and managed servers, and prompts for confirmation.  

Complete these steps:  

1. Type 1 and press Enter if you are ready to continue with setup. If, however, you 

need to shut down your servers, type 2 and press Enter to quit. 

2. Assuming you pressed 1 in step 1, the script prompts you to enter these values: 

• MW_HOME: The full path to the home directory of the GRCI middleware 

installation. 

• JAVA_HOME: The full path to the Java deployment used for the middleware 

installation (the JDK instance you confirmed to be in the path to install and 

run WebLogic.)  

• RCU_HOME: The full path to the highest-level directory in which the RCU 

11.1.1.9 component exists.  

• DOMAIN: The full path to the WebLogic domain you created for GRCI: 

<MW_HOME>/user_projects/domains/<grc_domain>. 

• ADMIN_SERVER_NAME: Your WebLogic Administration Server name. 

• HOST_PORT: The port number configured for your Administration Server. 

• HOST: The fully qualified domain name for the host on which you are per-

forming the GRCI installation. 

3. The script attempts to extract the HOST_IP — the IP address of the machine on 

which GRCI is being installed. Verify that the value is detected correctly.  

4. The script prompts you to enter these additional values: 

• DB_HOST : The fully qualified domain name for the machine that hosts the 

database that in turn hosts the DA schema. 

• DB_PORT : The listen port number for the database that hosts the DA schema. 

• SID : The instance name for the database that hosts the DA schema. 

• DB_NAME: The service name for the database that hosts the DA schema. 

• SYS_PASSWORD: The SYS user’s password for the database that hosts the 

DA schema. 

• WLS_ADMIN_USER: The administrator user name for the WebLogic instance 

dedicated to GRCI. 

• WLS_ADMIN_PASSWORD: The administrator password for the WebLogic in-

stance dedicated to GRCI. 

5. The script performs string replacements inside installation files based on the 

setting values you’ve supplied, and it creates two RCU schemas. 

6. The script launches a GUI wizard in which you can extend the domain you 

created for GRC. To do so, follow steps in “Extending Your Domain” (page 

35). Then continue this procedure at step 7.  
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7. Open another terminal window. In it, open <MW_HOME>/user_projects/ 

domains/<grc_domain>/bin/setDomainEnv.sh in a text editor, and locate the 

following lines: 

# IF USER_MEM_ARGS the environment variable is set, use it 

to override ALL MEM_ARGS values 

if [ "${USER_MEM_ARGS}" != "" ] ; then 

Insert the following  between those two lines: 

case "${SERVER_NAME}" in  

"AdminServer") 

  USER_MEM_ARGS="-Xms2g –Xmx2g" 

;; 

"bi_server1") 

  USER_MEM_ARGS="-Xms2g –Xmx8g" 

;; 

*) 

  echo "Unknown Server Detected!!. Memory set as Xms1g 

Xmx2g."; 

USER_MEM_ARGS="-Xms1g -Xmx2g" 

;; 

esac 

USER_MEM_ARGS="${USER_MEM_ARGS} -XX:PermSize=256m  

-XX:MaxPermSize=512m -XX:ReservedCodeCacheSize=128M  

-Djava.awt.headless=true -Djbo.ampool.maxpoolsize=600000  

-Dfile.encoding=UTF-8" 

You may use a maximum memory settings (-Xmx) larger than the values shown 

above  if your server has enough memory to support the larger values. 

8. Return to the window in which the script is running, enter the value 1, and press 

the Enter key so that the script continues. The installation script continues to per-

form automated installation operations.  

9. Complete the “Repository and WebCat Configuration” section (page 38) to 

update the rpd file with correct connection values. 

10. Complete the “Deploying GRCDiagnostic.rpd and Updating Scheduler Creden-

tials” section (page 39). 

Extending Your Domain 

While install_obiee.sh runs, it presents a GUI wizard in which to extend the 

WebLogic domain you created for GRCI. Follow these steps to extend your domain. 

OWSM MDS and EPM schemas are the only two schemas you need to modify in 

the following steps.  

1. Select Extend an existing WebLogic domain. 

2. Click Next. 

3. Select to extend the <MW_HOME>/user_projects/domains/<grc_domain> 

directory. 

4. Click Next. 

5. Click Extend my domain using an existing extension template. 
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6. Click Browse. 

7. Navigate to <MW_HOME>/Oracle_BI1/common/templates/applications/ and 

select oracle.bi_base_enterprise_template_11.1.1.jar. 

8. Click OK. 

9. Click Next. 

10. Select both OWSM MDS and EPM schemas and enter the following values: 

• Vender: Oracle 

• DBMS/Service: The service name for the GRC database. 

• Driver: Accept the default value. 

• Host Name: The fully qualified domain name for the machine that hosts the 

GRC database. 

• Schema Password: grc 

• Port: The port number at which the GRC database communicates with other 

applications. 

11. Unselect OWSM MDS Schema while leaving EPM Schema selected. As 

Schema Owner, enter the value EGRCM_BIPLATFORM. 

12. Unselect EPM Schema and select OWSM MDS Schema. As Schema Owner, 

enter the following value: EGRCM_MDS. 

13. Click Next. 

14. If the connection tests for both schemas succeed, click Next. Otherwise, click 

Previous and enter correct values. 

15. Select Managed Servers, Clusters and Machines. 

16. Click Next. 

17. Modify the Listen address field for bi_server1 to the IP address of the machine 

on which you are installing GRCI. 

18. Click Next. 

19. Click Next. 

20. Click Next. 

21. Click Next. 

22. Click Extend. 

23. Click Done. 

24. The GUI wizard closes and another one launches to extend the domain with 

further Oracle Business Intelligence features. Select Extend an existing 

WebLogic domain. 

25. Click Next. 

26. Select to extend the <MW_HOME>/user_projects/domains/<grc_domain> 

directory. 

27. Click Next. 
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28. Select Oracle BI Enterprise Edition — 11.1.1.9.0. Additional products are 

selected automatically. 

29. Click Next. 

30. Click Next. 

31. Click Next. 

32. Select Deployments and services. 

33. Select bi_cluster from the Target pane in the left. 

34. Unselect the following Applications (clear the checkmark next to each): 

• DMS Application#11.1.1.1.0 

• wsil-wls 

• ESSAPP 

• wsm-pm 

• bilocaladmin#11.1.1 

• bicontentserver#11.1.1 

• bicomposer#11.1.1 

• asyncadminserver#11.1.1 

• jbips#11.1.1 

• bioffice#11.1.1 

• biofficeclient#11.1.1 

• analytics#11.1.1 

• bimiddleware#11.1.1 

• bisearch#11.1.1 

• bisecurityadmin#11.1.1 

• bisecurity#11.1.1 

• mapviewer#11.1.1 

• adminservice#11.1.1 

• biadminservlet#11.1.1 

35. Select bi_server1 from the Target pane in the left. 

36. Check the applications listed in step 34. 

37. Click Next. 

38. Click Next. 

39. Click Extend. 

40. Click Done. 

Return to step 7 on page 35. 
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Repository and WebCat Configuration 

Extract and copy custom files that are consumed by GRCI dashboards and reports: 

• Locate the file grc-reportservices-8.6.6.3-SNAPSHOT-obiee-artifacts.zip in your 

<grc_stage>/dist directory (see “Downloading Files” on page 3). Extract its 

contents into a temporary directory. (Throughout this document, <OBIEE_TEMP> 

represents the full path to this directory.) 

• Copy <OBIEE_TEMP>/Webcat/GRCDWebcat to <MW_HOME>/instances/ 

instance1/ bifoundation/OracleBI PresentationServicesComponent/ 

coreapplication_obips1/catalog. (Use the R option of the cp command.) 

Modify a file called GRCDiagnostic.rpd, and then use it to configure repositories. 

To do so, you must use a tool that runs only on a Windows-based computer. 

Throughout this section (as before), host is the FQDN of your GRC server, and port 

is the number you selected for the WebLogic Administration Server.  

1. On a Windows machine, open an FTP client and connect to host.  

• Navigate to <OBIEE_TEMP>/repository.  

• Download the file GRCDiagnostic.rpd to you Windows machine. Then 

close the FTP client. 

2. On the Windows machine, go to http://host:9704/analytics. From that site, 

download and install Oracle Business Intelligence Developer Client Tools 

Installer (64-bit or 32-bit, depending on your Windows machine). 

3. When the installation is complete, ODBC Data Source Administrator opens. 

Press Cancel to close it (it is not needed for this procedure.) 

4. Open the Oracle BI Administration Tool: From the Start menu, navigate to 

Oracle Business Intelligence Enterprise Edition Plus Client → Administration.  

5. Navigate to File → Open → Offline. Select the GRCDiagnostic.rpd file you 

downloaded in step 1. Enter Admin123 as the Repository Password. 

6. Navigate to Manage → Variables. 

• In the left pane, expand Repository and select Variables. 

• In the right pane, double-click on GRI_DSN. Under Default Initializer, enter 

the service identifier (SID) for the Oracle database that hosts your DA 

schema, inside the single quotation marks. Press OK. 

• Double-click on GRI_USER_ID. Under Default Initializer, enter the schema 

name used by your DA schema, inside the single quotation marks. Press OK. 

• Close the Variable Manager. 

7. In the main window under the Physical section, right-click on GRC Diagnostics 

and select Properties. 

• Click on the Connection Pools tab and double-click on GRCI Connection 

Pool. 

• Under the Shared Logon section, enter the schema password used by your 

DA schema. 
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• Press OK, re-enter the schema password in the confirmation pop-up, and 

then press OK again. 

• Double-click on INIT BLOCK Connection Pool, and make the same pass-

word update as you made for the GRCI Connection Pool. 

• Press OK to close the Properties window. 

8. Navigate to File → Save and answer No to “Do you wish to check global 

consistency?” 

9. Exit the Oracle BI Administration Tool.  

Deploying GRCDiagnostic.rpd and Updating Scheduler Credentials 

Complete the following steps: 

1. Still on the Windows machine, go to http://host:port/em. Log in to the host with 

your WebLogic Administration username and password. 

2. From the left menu, expand Business Intelligence and double-click on 

coreapplication. 

3. Select the Deployment tab. 

4. Select the Scheduler tab. 

5. Press Lock and Edit Configuration. 

6. Close the confirmation pop-up. 

7. Update the username to EGRCM_BIPLATFORM. 

8. Update the password and confirm password fields to grc. 

9. Click the Apply button. 

10. Click on the Activate Changes button on top. 

11. Click on Close after the changes are activated. 

12. Press Lock and Edit Configuration. 

13. Select the Repository tab. 

14. Under Upload BI Server Repository, click the Browse button and select the 

GRCDiagnostic.rpd that you modified and saved on your Windows machine in 

“Repository and WebCat Configuration” (page 38). Enter Admin123 in both of 

the Repository Password and Confirm Password fields. 

15. Under BI Presentation Catalog, enter the following as the Catalog Location: 

<MW_HOME>/instances/instance1/bifoundation/OracleBIPresentationServicesC

omponent/coreapplication_obips1/catalog/GRCDWebcat 

16. Click on the Apply button. 

17. Click on the Activate Changes button on top. 

18. Click on Close after the changes are activated. 

19. Navigate to Business Intelligence → Core Application → Capacity 

Management → Performance. There, ensure that the cache is disabled (that the 

Enable BI Server Cache check box is cleared). 



 

40 Oracle Enterprise Governance, Risk and Compliance Installation Guide 

20. Press the Restart to apply recent changes button on top. 

21. Click on the Restart button. 

22. Select Yes. 

23. Click on Close after the restart completes. 

As long as the following BI components are up and running, warnings or errors 

related to any other components can be ignored. You can verify the status of these 

components by clicking on the Availability tab. If any of them are down, see the 

Troubleshooting section. 

• BI Presentation Services 

• BI Servers 

• BI Schedulers 

• BI Cluster Controllers 

• BI Java Hosts 

Configuring Intelligence in GRC 

Within the GRC application, you need to enter values that enable GRC to connect to 

OBIEE, and you need to select “dashboards” in which GRC displays reports.  

1. Log on to GRC (see “GRC Log-On URL” on page 7). Select Navigator → Tools 

→ Setup and Administration → Setup → Manage Application Configurations → 

Analytics. 

2. In the GRC Intelligence Configuration section, supply the following values: 

• OBIEE Server Username: If your GRC installation uses WebLogic, this is 

the user name configured for the WebLogic Administration Server.  

• OBIEE Server Password: The password for the GRCI Administration 

Server Username. 

• OBIEE Server Port: If your GRC installation uses WebLogic, this is 9704.  

• OBIEE Server Host: If your GRC installation uses WebLogic, this is the 

fully qualified domain name for the machine on which you installed GRCI.  

• Root Context: analytics 

Leave the Enable SSL Authentication check box unchecked. 

3. An Intelligence Page Configuration section displays a row for each dashboard 

you can display for GRC. (Each is identified as a “subtab” of an Intelligence tab 

that appears in, or in reference to, a major GRC page, such as the home page or 

an overview page for an object such as risk or continuous control.) 

• To enable a dashboard, click in its field in the Enable column until a check 

mark appears. To disable it, double-click until the check mark disappears. 

• To modify the display name of a dashboard, double-click in its field in the 

Display Label column. The field becomes write-enabled; enter the name 

you want to use. 
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4. A GRCI Intelligence Standard Mode Link Configuration section contains a 

single field, GRCI Intelligence Standard Mode URL. If you have installed a 

standalone instance of OBIEE, enter the URL for that instance.  

5. When you finish entering values, click on Action → Save. If you’ve modified 

settings in the GRC Intelligence Configuration section, GRC tests the values 

you’ve entered and, if they are valid, saves them. (If any are invalid, an error 

message instructs you to re-enter them.) 

6. Look for the prompt, “Successfully saved configuration values.” 

In addition, each GRC user who is to have access to GRCI must be granted one or 

more of three GRC job roles: GRC Intelligence Administrator Job Role, GRCM 

Embedded Intelligence Viewer Job Role, and CCM Embedded Intelligence Viewer 

Job Role. For information on adding job roles to GRC user accounts, see the Enter-

prise Governance, Risk and Compliance User Guide.  

Testing the Installation 

As a first test, bring up both the WLS and BI servers. Open a browser and go to 

http://host:9704/analytics. (In this URL, host is the FQDN of the machine on which 

you installed GRCI.) Log in with your GRCI WebLogic Administration username 

and password.   

Ensure that after login you can see subject areas under New → Analytics and can 

see multiple folder options under catalog. 

Second, ensure that the GRCI dashboard loads with no error in your GRC 

application: 

1. Ensure that the DA schema has been refreshed (see page 31). 

2. Log on to GRC (see page 7). Use the logon credentials of a user who has been 

assigned GRCI job roles. 

3. Click on the Intelligence tab for each of the home and overview pages in which 

you’ve enabled a GRCI dashboard. (See step 3 of “Configuring Intelligence in 

GRC,” page 40.) 

If you see no errors, the integration has been successful. 

Troubleshooting 

As you install GRCI, you may encounter the following problems: 

• An invalid property value is entered, and the installation script has run through 

the string replacement stage. 

You must start over. However, before running the installation script, you must 

either remove the obiee.properties and installation.stages files from your 

<MW_HOME> directory, or find the invalid value in obiee.properties and fix it 

after deleting the installation.stages file. 

• An invalid property value is entered, and the installation script has not run 

through the string replacement stage. 
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Simply remove the obiee.properties and installation.stages files from your 

<MW_HOME> directory and start the script over to go through the properties 

questionnaire. 

• The installer skips through a stage that needs to be redone. 

Edit the installation.stages file and remove the line that has the flag corre-

sponding to the stage you are trying to redo. 

• After BI components are restarted, one or more of them are not running. 

Depending on which component fails to start, look in 

<MW_HOME>/instances/instance1/diagnostics/logs/<OracleBIComponentName>

coreapplication_obis1 and examine the log files that were modified most 

recently. They will contain information you can use to resolve the startup issue. 

• You see SQL errors in GRCI dashboards, or any of your OBIEE components 

fail to start. 

Check the following logs for more information on the errors.  

– Presentation Services Log: 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIPresentationSer

vicesComponent\coreapplication_obips1\sawlogo.log 

– BI Server Component: 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIServerCompon

ent\coreapplication_obis1\nqquery.log  

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIServerCompon

ent\coreapplication_obis1\nqserver.log  

– BI Scheduler Component: 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBISchedulerCom

ponent\coreapplication_obisch1\nqscheduler.log 

– BI Cluster Component: 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIClusterControll

erComponent\coreapplication_obiccs1\nqcluster.log  

– Java host Component: 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIJavaHostComp

onent\coreapplication_obijh1\jh.log 

• After the RPD is deployed and BI components are restarted, only the BI Presen-

tation Services Component is down and the following appears in 

<MW_HOME>\instances\instance1\diagnostics\logs\OracleBIPresentationService

sComponent\coreapplication_obips1\sawlogo.log: 

Unable to create a system user connection to BI Server 

during start up. Trying again. 

and 

Error connecting to the Oracle BI Server: Could not connect 

to the Oracle BI Server because it is not running or is 

inaccessible.  Please contact your system administrator. 
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Wait a few minutes. Then complete these steps to restart just the BI Presentation 

Services Component:  

1. Follow step 1 and 2 of “Deploying GRCDiagnostic.rpd and Updating 

Scheduler Credentials” (page 39) to log in to the Enterprise Manager and 

open the coreapplication settings page. 

2. Click on the Availability tab. 

3. Click on BI Presentation Services to select it. 

4. Click Restart Selected. 

5. Click Yes to confirm. 

6. Press Close. 

• Other problems. 

Check <MW_HOME>/installation.log or <MW_HOME>/instances/instance1/ 

diagnostics/logs/<OracleBIComponentName>coreapplication_obis1. Look for an 

error message to help you gather more information on the problem and possibly 

lead you to its resolution. 
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4 

Additional Advanced Controls Configuration 

Once you’ve upgraded GRC, complete additional configuration procedures as 

needed if you intend to use AACG or ETCG: 

• Define information with which GRC creates “global users.” Business applica-

tions subject to models and controls may have user-account information that 

varies from one application to the next. GRC maps each person’s business-

application IDs to a global-user ID. You can determine what information GRC 

uses to do so.  

If you are upgrading, the new version inherits the global-user definition from 

your earlier version. If you are satisfied with your configuration for the earlier 

version, you need not redefine it. 

• Decide whether to implement a Page Access Configurations business object, 

which enables AACG users to build models and controls that take PeopleSoft 

user preferences into account. This feature is enabled by default. If your access 

models and controls do not cite PeopleSoft user preferences, you can disable 

this feature to improve performance and reduce memory requirements. 

• Set up data sources — connections to business applications in which GRC is to 

perform analysis. However, if you are upgrading, the new version inherits data 

sources configured for your earlier version. In the new version, you need to set up 

only new data sources. 

• Complete the following procedures in the order indicated: 

1. Perform access synchronization on all data sources used for AACG analysis 

(see “How to Synchronize Data,” page 51).  

2. Perform a graph rebuild on all data sources used for ETCG analysis (again, 

see “How to Synchronize Data” on page 51). 

3. Run all controls that compile data for user defined objects (controls for which 

the result type is “Dataset”). 

4. Run all models and all controls that generate incidents (controls for which the 

result type is “Incidents”). 

Note, however, that if you are upgrading through several releases, then synchronize 

access data, rebuild the graph for transaction data, and run controls and models only 

once, after the final upgrade is complete. For information on running models and 
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controls, and distinguishing between control types, see the user guides for AACG 

and ETCG. 

Configuring Global Users 

Implement one of the following options to determine the information GRC uses to 

create global users. Important: Select an option that identifies each person uniquely. 

• EMAIL_ONLY: Match the global user to email addresses from distinct data 

sources (or within one data source). This is the default. 

• EMAIL_AND_USERNAME: Match the global user to email address plus username 

from distinct data sources (or within one data source). Because PeopleSoft imple-

mentations often do not use the email address for users, customers who imple-

ment PeopleSoft usually select this option as well. 

• EMAIL_AND_ALL_NAMES: Match the global user to email address, username, 

given name, and surname from distinct data sources (or within one data source). 

GRC users regularly synchronize data and analyze controls to produce “incidents” 

(records of control violations). If no data has been synchronized and no controls have 

been analyzed (in the upgrade version or any earlier version), complete the following 

three steps to change a global-user configuration.  

1. Use SQL*Plus, or any other tool with the ability to execute SQL commands on 

a database, to connect to the GRC schema.  

2. Run the following SQL statement: 

DELETE FROM GRC_PROPERTIES 

WHERE NAME like 'GLOBAL_USER_CONFIG'; 

COMMIT; 

3. Run one of the following SQL statements, depending on the global-user format 

you want to implement: 

For email and username, run the following statement: 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID)Values ('GLOBAL_USER_CONFIG', 

'EMAIL_AND_USERNAME', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 

0, 0, 0); 

COMMIT; 

For email, username, given name, and surname, run the following statement: 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID) Values ('GLOBAL_USER_CONFIG', 

'EMAIL_AND_ALL_NAMES', 'Global User configuration. Possible values: 

EMAIL_ONLY, EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 

0, 0, 0);  

COMMIT; 

For email only, run the following statement. (As already noted, email-only is the 

default configuration. Run this statement only if you have changed your global-

user configuration to one of the other formats, and want to change back.) 

Insert into GRC_PROPERTIES (NAME, VALUE, DESCRIPTION, DEFAULT_VALUE, 

VISIBLE, CONFIGURABLE, DATA_TYPE_ID) Values ('GLOBAL_USER_CONFIG', 
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'EMAIL_ONLY', 'Global User configuration. Possible values: EMAIL_ONLY, 

EMAIL_AND_USERNAME, EMAIL_AND_ALL_NAMES', 'EMAIL_ONLY', 0, 0, 0); 

COMMIT; 

A second possibility is that data has been synchronized, but controls have not been 

analyzed. If so, changing your global-user configuration wipes out all existing global-

user data. 

1. Complete the steps outlined above for the first global-user-configuration sce-

nario (in which data synchronization and control analysis have not occurred). 

2. Sill logged on to your SQL tool, also run the following SQL statement: 

TRUNCATE TABLE GRC_SRC_USER_MAPPING; 

TRUNCATE TABLE GRC_GLOBAL USER; 

COMMIT; 

A third possibility is that data has been synchronized, controls have been analyzed, 

and incidents have been generated. In this case, when you change your global-user 

configuration, all existing incidents become invalid, and all existing global-user data 

is wiped out.  

1. Log on to GRC (see “GRC Log-On URL,” page 7).  

2. From the Navigator, select Tools → Setup and Administration → Setup → 

Manage Application Configurations. Select the Maintenance tab, and from the 

Maintenance page, purge all existing incidents. (For detailed instructions on 

purging incidents, see the Governance, Risk and Compliance User Guide.) 

3. Still logged on to GRC, select Navigator → Continuous Control Management 

→ Results Management → Manage Incident Results. In a Manage Results page, 

select Incident Result in the View By list box. Confirm that no incidents exist.  

4. Log off of GRC and shut down the application server.  

5. Complete the steps outlined above for the first global-user-configuration sce-

nario (in which data synchronization and control analysis have not occurred). 

6. While logged on to your SQL tool, also run the following SQL statement: 

TRUNCATE TABLE GRC_SUM_CTRL_INC; 

TRUNCATE TABLE GRC_SRC_USER_MAPPING; 

TRUNCATE TABLE GRC_GLOBAL USER; 

COMMIT; 

7. Clear the contents of your Transaction ETL Path folder. (This folder is specified 

as GRC properties are set. See “GRC Configuration,” page 7.) 

Enabling or Disabling Page Access Configurations 

An access model or control may include filters that serve as conditions — they 

specify users or other objects that are exempt from analysis. Like any other access 

filter, a condition filter specifies a business object — a set of related fields from a 

data source (business application). A business object called Page Access Configura-

tions makes PeopleSoft user-preference values available for use in condition filters. 

By default, processing of data provided by this business object is enabled. 
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If your site does not use PeopleSoft user-preference values in access models and con-

trols, you may choose to disable the processing of Page Access Configurations data. 

This improves performance and reduces memory requirements.  

Important Note: If you disable Page Access Configurations data processing, the 

business object will nevertheless appear to be available for use in models. Users may 

create filters that cite this object, but GRC will ignore those filters. This may cause 

models (and controls developed from those models) to return results that differ from 

those that users expect. If you disable Page Access Configurations data processing, 

alert users not to use the Page Access Configurations business object as they create 

models.  

To disable Page Access Configurations data processing: 

1. Shut down the GRC application server. 

2. Use SQL*Plus, or any other tool with the ability to execute SQL commands on 

a database, to connect to the GRC schema. 

3. Run the following SQL statement 

update GRC_PROPERTIES set VALUE = 'FALSE' where NAME = 

'grc.access.user.preferences'; 

COMMIT; 

4. Restart the GRC application server.  

Configuring Data Sources and Synchronizing Data 
Connect GRC to data sources (instances of business-management applications that 

are to be subject to GRC models or controls). Also synchronize data for each data 

source — collect information required for AACG or ETCG analysis. 

Synchronization and Global Users 

The order in which you synchronize access data from data sources determines how 

GRC creates global-user IDs: It adopts the ID configured for each user in the first 

data source to be synchronized. When data from a second data source is synchronized, 

GRC matches users who also exist in the first data source to their already-existing 

global-user IDs. For each user who did not exist in the first data source, GRC adopts 

the user ID from the second data source as the user’s global ID. And so on. 

AACG pages display the global-user ID for each business-application user. You may 

prefer to set IDs from a particular data source as the global-user IDs. 

However, during an upgrade, GRC inherits the global-user IDs existing on the 

earlier version. For the new version, global-user IDs are initially the same as they 

were for the earlier version. 

If you modify the global-user configuration (see page 46), existing global-user IDs 

are wiped out. In that case, or as you add new data sources, consider the following:  
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Configure all data sources in which you expect to apply AACG models and controls 

before you synchronize data for any of them. Next, choose a data source from which 

you want GRC to adopt IDs as global-user IDs, and synchronize that data source 

first. Establish an order for the remaining data sources, each of which sets global 

IDs for users who do not exist in the data sources for which synchronization has 

already been completed. Then synchronize the remaining data sources in that order. 

To configure data sources or to synchronize their data, log on to GRC (see “GRC 

Log-On URL,” page 7). Select Setup and Administration under Tools in the Naviga-

tor, then Manage Application Datasources under Setup. 

Special Cases Involving SQL Server 

You must install the Microsoft JDBC Driver 4.0 for SQL Server if your GRC instance 

connects to a Microsoft SQL Server data source and if either of the following is true: 

• Your GRC instance runs with Tomcat Application Server. 

• Your GRC instance runs with WebLogic and implements Secure Sockets Layer. 

Install the driver before you synchronize data for the SQL Server data source. How-

ever, if you are upgrading and have already competed this procedure for your earlier 

GRC version, you need not reinstall the driver.  

On the GRC server: 

1. Download the UNIX version of the JDBC driver — sqljdbc_*.tar.gz — from 

http://msdn.microsoft.com/en-us/data/aa937724.aspx. 

2. Shut down your application server. 

3. From the download file, extract the JDBC driver for SQL Server 2005 and 

newer — sqljdbc4.jar. (A SQL Server 2000 driver is also included in the down-

load file, but is not supported by GRC.) 

4. Copy the sqljdbc4.jar file to a directory appropriate for your application server: 

• If you use Tomcat, the directory is <TomcatHome>/webapps/grc/WEB-

INF/lib. 

• If you use WebLogic, the directory is <MW_HOME>/user_projects/domains/ 

<grc_domain>/lib 

5. If you use WebLogic, edit the setDomainEnv.sh file. (Skip this step if you use 

Tomcat.) 

The setDomain Env.sh file is located in the <MW_HOME>/user_projects/ 

domains/<grc_domain>/bin directory. In it, locate the following line: 

if [ "${PRE_CLASSPATH}" != "" ] ; then 

Immediately before that line, add the following line: 

PRE_CLASSPATH="<MW_HOME>/user_projects/domains/<grc_domain>

/lib/sqljdbc4.jar:${PRE_CLASSPATH}" export PRE_CLASSPATH 

Replace <MW_HOME> and <grc_domain> with the specific values appropriate 

for your environment. 

6. Restart your application server. 
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How to Configure Data Sources 

To configure a data source, complete these steps. However, remember that the new 

version inherits data sources configured for your earlier GRC version, and you need 

not reconfigure them.  

1. In the GRC Manage Application Datasources page click on Actions → Create 

New. A Create Datasource window opens. Enter the following values: 

• Datasource Name: Create a name for the data source. 

• Description: Type a brief description of the data source (optional). 

• Application Type: Select the type of business application to which you are 

connecting, such as EBS or PeopleSoft. 

• Application Type Version: Select the version number of the business-

management application to which you are connecting. 

• Default Datasource: Select the checkbox to make the data source you are 

configuring the default for use in transaction models. Only one data source 

can have this value selected. 

• Connector Type: For an Oracle EBS or PeopleSoft data source, select 

Default. For any other application, you would need to have created and 

uploaded a custom connector; select it. 

• Connector Properties: Enter values required for the connector you specified 

in Connector Type. Values vary by connector. They may include: 

– ERP Database Type: Select the type of database — Oracle, Oracle RAC, 

MS SQL Server, DB2, or MySQL — used by the business-management 

application being configured as a data source. 

– Hostname: For Oracle EBS or PeopleSoft, supply the FQDN for the 

machine that hosts the database used by the business-management 

application. Or, if the database is RAC-enabled, enter 

RAC@<SCAN_NAME>, where <SCAN_NAME> is the IP 

address/host name configured for the RAC database. 

– Service Name: For Oracle EBS or PeopleSoft, supply the SID value 

configured for the business-application database in the tnsnames.ora 

file. Or, if the database is RAC-enabled, enter the RAC service name 

configured for the RAC database. 

– Port: For Oracle EBS or PeopleSoft, enter the port number that the busi-

ness-application database uses to communicate with other applications.  

– Username: For Oracle EBS or PeopleSoft, supply the user name for the 

business-application database. (For an Oracle database, this is the same 

as Schema Name; for an Oracle EBS instance, this is typically APPS.)  

– Password: Supply the password that authenticates the user name for the 

business-application database. 

2. After entering values, click on the Test Connection button.  

3. When the test completes successfully, click the Save or Save and Close button. 

A row representing the data source appears in the Manage Application Data-

sources grid. 
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How to Synchronize Data 

You must synchronize data from every data source used for access analysis, and 

“rebuild the graph” for every data source used for transaction analysis — even data 

sources inherited from your earlier GRC version.  

An ordinary synchronization run creates or updates only records that are new or 

have changed since the previous synchronization. A graph rebuild deletes all data 

for a given data source and replaces it with a complete set of current data. This 

typically takes longer than ordinary synchronization. 

To synchronize access data, complete these steps: 

1. In the Manage Application Datasources page, select the row for the data source 

with which you want to synchronize data.  

2. Click on Actions → Synchronize Access. 

3. A confirmation message appears; click its OK button. 

To rebuild the graph for transaction data, complete these steps: 

1. In the Manage Application Datasources page, select the row for a transaction 

data source. 

2. Select Actions → Rebuild Graph. 

3. A confirmation message appears; click its OK button. 

There is an option to synchronize transaction data; it’s the preferred option for routine 

use of ETCG. However, do not use it in this instance. During a GRC upgrade, you must 

perform a graph rebuild on transaction data sources. 

Each time a data source is synchronized, GRC updates fields in the row for that data 

source: Last Access Synchronization Date and Last Access Synchronization Status 

show the date of the most recent access synchronization, and its completion status. 

Last Transaction Synchronization Date and Last Transaction Synchronization Status 

do the same for the most recent transaction synchronization or graph rebuild. 

Determining Data Source IDs 

When you configure a data source, GRC assigns an ID number to it. If you intend to 

implement preventive analysis for an Oracle EBS datasource, you need to know its 

data source ID. To determine the number, configure the data source, then complete 

the following steps: 

1. In the Manage Application Datasources page, select View → Columns.  

2. A list of available columns appears. In it, select Datasource ID. 

3. The Manage Application Datasources page now displays a Datasource ID 

column. In it, note the ID number assigned to the data source you’ve 

configured. 

If, having determined the data source IDs for your data sources, you wish to remove 

the Datasource ID column from view, repeat this procedure but clear the Datasource 

ID selection.  
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5 

Installing PEAs 

In support of the AACG preventive analysis feature, ensure that a Preventive 

Enforcement Agent (PEA) is installed on each Oracle EBS instance that is to be subject 

to AACG analysis.  

There is no new PEA for release 8.6.6.11000. If you have already installed a PEA 

for the prior GRC release, you were encouraged to use an automated procedure to 

do so, and to resort to a manual procedure if the automated procedure failed: 

• If the automated procedure ran successfully, you can use the already installed 

PEA. You need do nothing further. 

• If you used the manual procedure, you need not reinstall the PEA, but you do 

need to complete a procedure that makes insertions into lookup tables. It’s 

documented below. 

If you want to set up an EBS instance as an access data source, and that instance 

does not have a PEA, you need to install one. 

• See the Oracle Enterprise Governance, Risk and Compliance Certifications 

Document for supported versions of Oracle EBS. 

• See the GRC Installation Guide for version 8.6.6.6000 for the procedure to 

install an Oracle EBS PEA. Add to it the lookup-table-insertions procedure 

documented below. 

Lookup Table Insertions 

From your staging directory, execute the following command to insert records in an 

LAA_lookup table. In this command, xxlaappsSchemaName and 

xxlaappsSchemaPassword are the user name and password of the database schema 

used by Preventive Controls Governor. (Note that version 7.3.3 of Preventive Con-

trols Governor must be installed on an Oracle EBS instance before the PEA can be 

installed.) 

Sqlplus xxlaappsSchemaName/xxlaappsSchemaPassword 

@db/addproperties.sql 
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